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Adding animation to a Style

If the current style supports animation, the Animation Playback button on theLiveArt toolbar will be active.

1. Click on the Animation Playback button to get the Animation Playback toolbar.

2. To start the animation, click on the leftmost button on the toolbar. 
Note that you can move the model around while it is animating.

3. To stop the animation, click again on the button to toggle it off.

4. To set the frame position in the animation, press the First Frame, Previous Frame, Next Frame, or Last Frame buttons on 
the Animation Playback toolbar.

You can also type a frame number in the text box at the center of the toolbar and step the animation forward or backward from 
that point.

5. Use the rightmost button on the toolbar to toggle between a single playback and a continuous loop.



Animating in MS PowerPoint

You can preview an animation in MS PowerPoint by using the Animation Toolbar.

You can also have PowerPoint run your animation automatically during your presentation.
Use the following steps    to do this:

1. If the canvas is inactive, click on it to activate it.

2. Click the Play button on the left side of the Animation Toolbar.

3. Click outside the canvas to deactivate it.

4. Click on the canvas once with the right mouse button.

5. Select Custom Animation from the PowerPoint toolbar.

6. Select Play Settings and choose Play from the pop up menu.

7. Select Timing and choose when you want to the animation to begin.

8. To play the animation, select View Show from the Slide Show menu.

 



Animation Overview

Some models have built-in animation that you can use to liven your presentations. You'll know you have such a model because it 
will be animated in the Preview window in the LiveArt catalog. When you insert an animated model in a canvas,    the Animation 
toolbar will appear. You can use this toolbar to run through the animation. Even if you are preparing a printed report rather than a 
presentation, you can "step through" the animation to find the most interesting still picture.

 



Changing Styles

Styles are different ways of approaching the depiction of the model. They mimic different ways an artist might look at the scene. 
Each model has a variety of styles that you can choose. Each style sets a variety of features such as the way lines are drawn, the 
contrast between foreground and background, the kind of shading, and so on.

To change the style for the current model:

1. Make sure the canvas is active. (If not, double-click on it.)

2. Pull down the style list box

3. Select the style you want

 



Changing the Background Color or Texture

Some styles have a solid background color that you can change to another color. Other styles have special textured backgrounds 
that you can change to another texture or remove and replace with a solid color.

1. On the LiveArt toolbar, click on the button that shows a rectangle with a scene in it. A menu
will pop up.

2. Select either the default background for the style or one of the squares showing possible background colors.

If the style uses a textured background, select the texture or solid color as appropriate.

 



Changing the Lights

Most styles let you change the direction from which light appears to enter the picture.

1. To change the direction of the light, click on the button on the toolbar that shows a light bulb.

2. On the drop-down box, click on the little lamp (light cone)    that shows the desired direction of lighting. Note that center symbol 
represents light coming straight at the viewer.

3. Click on the button with the light bulb and socket to toggle the lighting on or off. When the lighting is off, the result is like a 
shady day.



Changing the Line Color

In some styles you can change the color used to draw the primary lines that define the object. 
To change the line color for the current style:

1. Click on the button that shows a drawing pen. 

2. Click on the little square representing the color you want to use.



Changing the Line Thickness

Some styles offer a choice of several line thicknesses. This allows you to make a drawing look finely detailed with thin lines, or 
strong and bold with thicker lines. You can experiment with different line thicknesses to get the right feel for a particular model.

To change the line thickness in the current style:

1. Click on the button that shows several horizontal lines of different thicknesses.

2. Select the line thickness you want.

 



Changing the Model

If you want to pick a different piece of LiveArt to place in your document:

1. Double click on the LiveArt canvas to make it active.

2. Bring up the LiveArt Model Catalog.

3. Choose  a new model in the LiveArt Model Catalog..

4. Click the Insert button to insert the model into the canvas.
 



Changing the Object's Color

Some styles are set up to allow you to change the color used to fill in the object. If you have such a style, the Fill button (a picture of 
a paint can) will be active.

1. Click on the fill button.

2. Click on the square that represents the fill color you want.
Note that you can click on More Fill Colors to get additional color choices or to create a custom color.

 



Creating Transparent Backgrounds

You can use the MS Word or MS PowerPoint Picture toolbar to create a transparent background for your LiveArt model. (You might 
want to do this so you can superimpose your art over some text.)

1. With the canvas inactive, bring up the picture toolbar.

2. Click on the rightmost button on the picture control. This sets the background color.

3. Pick a color that does not appear anywhere in the model. Use the Set Transparent Color button to set that color.

The following illustrations show a step-by-step determination of an appropriate transparent color:



 



Exporting Art to Other Programs

You can copy LiveArt canvases or images to another program.

1. Open the document containing the LiveArt canvas you wish to copy.

2. If you want to copy the canvas (not just the image), double-click the canvas to make it active.

3. Open the application's Edit menu and select Copy

4. Open the document or application where you want to copy the art and click to place
the insertion point if necessary.

5. Open the application's Edit menu and select Paste.

Note: if you copy from an active LiveArt canvas to an application that supports LiveArt OLE objects, the copy will be a LiveArt 
canvas. If you copy from an inactive LiveArt canvas or copy to an external image program such as MS Paint, only a bitmapped 
image will be copied, not the canvas.



Finding the Art You Want

It's easy to find the model you need from LiveArt's extensive library. Assuming you have brought LiveArt into MS Word or MS 
PowerPoint, follow these steps to find, preview, and select a LiveArt model:

· Make sure the LiveArt CD is in the drive. Once you have inserted a LiveArt canvas in your document, the LiveArt catalog will 
appear.

· Type in a word that describes the subject you are looking for (for example, cat), and press Enter. All models matching that 
keyword (or related concepts) will appear in the list box at the left. (You can learn more about searching for art.)

· You can also click the arrow to the right of the text box and pull down a list. The top of the list "remembers" keywords you've 
used recently. The bottom of the list has some categories such as accessories, nature, and transportation. If you click on the 
special category "Surprise Me" LiveArt will serve up a random assortment of images for you to consider.

· Select the model you want to see by clicking on it in the list. A preview image will appear in the window to the right.

· To rotate the preview image, click on it, hold down the left mouse button, and move the mouse pointer clockwise or 
counterclockwise.

· To zoom the preview image in or out, click on the image and hold down both the left and right mouse buttons. Move the mouse 
toward the image to make it bigger, or pull the mouse back to shrink the image.

· To add the model to your document, click on the Insert button. (If you want to insert just the model without any background, 
click on the Insert Model Only button.)





Getting More From LiveArt

More LiveArt models and LiveStyles will be available. The best way to find out is to check the Viewpoint Datalabs
web site. Click here to go there!
 



Getting Technical Support

There are several ways to get technical support for Viewpoint LiveArt:

· The Viewpoint Datalabs web site provides answers to many questions about the software, as well as announcements of new 
products.

Click here to go to the Viewpoint Datalabs web site. 

· You can also email support questions for LiveArt    to liveart-support@viewpoint.com. 

· The support team may also be directly reached toll-free from within the US at 888-544-0407, or from anywhere at 801-229-
3374.



active    A LiveArt canvas is active when it has the LiveArt toolbar and is ready to be customized within LiveArt. Double clicking on 
an inactive LiveArt canvas makes it active.



Animation toolbar    This toolbar appears only with models that support animation. It allows you to control how the animation runs. 



background    The background is the part of of the LiveArt canvas against which the model is drawn. 



canvas      The canvas is the container in your document that holds the LiveArt model and its background. 



inactive    A LiveArt canvas that is inactive cannot be worked on in LiveArt. Instead, it appears as an embedded picture in your 
document, and can be worked on using that application's Picture toolbar. Clicking within a document but outside the canvas makes 
the canvas inactive. 



LiveArt catalog    The LiveArt catalog is a browser that you can use to search for LiveArt models from the CD or other sources. 



LiveArt toolbar    The LiveArt toolbar is the main "control panel" that you use to work with an active LiveArt model in your document. 



model    The model is the drawing object depicted on a LiveArt canvas. It can be moved, rotated, sized, and customized in other 
ways. 



Picture toolbar    The Picture toolbar can be used in an application to work with an inactive LiveArt canvas, such as to brighten or 
crop the picture. (This toolbar belongs to the application, not to LiveArt. See the application's Help for information on how to use its 
Picture toolbar.) 



style    A style is a particular approach to rendering a model. Each style is a carefully chosen set of    line types, brush strokes, 
shading, background textures, and other features. Each model includes many styles, but not all styles are available for all models. 



Glossary of Terms

The following special terms are used in working with Viewpoint LiveArt.

active    A LiveArt canvas is active when it has the LiveArt toolbar and is ready to be customized within LiveArt. Double clicking on 
an inactive LiveArt canvas makes it active.

Animation toolbar    This toolbar appears only with models that support animation. It allows you to control how the animation runs.

background    The background is the part of of the LiveArt canvas against which the model is drawn.

canvas      The canvas is the container in your document that holds the LiveArt model and its background.

inactive    A LiveArt canvas that is inactive cannot be worked on in LiveArt. Instead, it appears as an embedded picture in your 
document, and can be worked on using that application's Picture toolbar. Clicking within a document but outside the canvas makes 
the canvas inactive.

LiveArt catalog    The LiveArt catalog is a browser that you can use to search for LiveArt models from the CD or other sources.

LiveArt toolbar    The LiveArt toolbar is the main "control panel" that you use to work with an active LiveArt model in your document.

model    The model is the drawing object depicted on a LiveArt canvas. It can be moved, rotated, sized, and customized in other 
ways.

Picture toolbar    The Picture toolbar can be used in an application to work with an inactive LiveArt canvas, such as to brighten or 
crop the picture. (This toolbar belongs to the application, not to LiveArt. See the application's Help for information on how to use its 
Picture toolbar.)

style    A style is a particular approach to rendering a model. Each style is a carefully chosen set of    line types, brush strokes, 
shading, background textures, and other features. Each model includes many styles, but not all styles are available for all models.
 



Sets the animation to the beginning frame. 



Shows the current frame number. Type a number to set the animation to that frame. 



Goes to the last frame of the animation. 



Toggles between running the animation just once (straight arrow) and continuously (loop). 



Toggle. Click to play. Click again to pause 



Steps back one frame. 



Steps forward to the next frame. 



Click this button to open the Animation Playback toolbar.
You can use this toolbar to control animation (not available in all models.)
 



Click this button    to set the background used for the model drawing.
Click a square on the pop-up menu to set background color or texture
or click Default to use default background
or  click More Colors for additional color choices or to create a custom color. 



Click this button to make the model smaller.
(You can click more than once.) 



1. Click to set the color to be used to fill the drawing.
(This is not available for all styles.)

2. Click a box on the pop-up menu to set the fill color.
or  click default color box to use default.
or  click More Colors button for additional color choices or to 
create a custom color.

 



Click this button to open the LiveArt help system. 



Click this button to make the model larger. 
(You can click more than once.)



Click on this button to select the direction from which light 
 will hit the model
 On the popup menu, click the lamp that faces the direction
 you want or click the bottom panel to toggle the
 light on or off.
 



Click here to select the thickness of lines used in the drawing.
Select a line from the pop-up menu.



1.  Click this button to select the color of the main lines in the drawing.
2.  Click on the pop-up menu to select a color or select the default color.
3.  Click More Colors for additional choices or to create    a custom color.



Use these four buttons to "nudge" the model up, down, left, or right. 



Click this button to open the bottom panel of the toolbar.
This contains controls you can use to position the model. 



Click here to bring up the LiveArt Catalog to choose a different model for this canvas. 



Click this button to restore the model's default position. 
To restore the model so that it faces a particular direction,    open the pull-down
menu and select the facing.



Pull down to select from the styles available for this model.
 



Use these two buttons to tilt the model clockwise or 
counterclockwise (looking down). 



Use these two buttons to turn the model to the left or right. 



Use these buttons to tilt the model up or down toward or away from you.. 



Installing LiveArt

1. Insert the LiveArt CD-ROM in the CD-ROM drive. 

2. Open the CD in Windows Explorer and double-click on Setup.exe, or
        Click start then run and type d:setup (where d is your CD's drive letter) and press Enter.

3. Follow the instructions on the screen.

LiveArt will install a button into the tool bar in Microsoft Word that you will use to
place LiveArt models into your documents.

You are ready to go! 

A Few Technical Notes

LiveArt uses OpenGL for rendering graphics. It will install a version of OpenGL if
it doesn't find one on your system. It will also install DirectX. OpenGL or Direct 3D
will be used for hardware graphics acceleration, depending on your graphics card.

The LiveArt CD must be in the CD-ROM drive for LiveArt to find new models.



Moving the Model Around the Canvas

Moving the Model around the Canvas
· To move the model freely around the canvas hold down the right mouse button and move the pointer to the desired location. 

The model will follow the pointer.

· To force the model to move only up/down or sideways, hold down the Shift key along with the right mouse button. 



Moving the Model with the Mouse

You can move, rotate, or zoom the model using the mouse. 
Click below to learn how to:

1. Move the model around the canvas.

2. Rotate the model in various directions.

3. Expand (zoom) or shrink the model.

 



Moving the Model with the Nudge Controls

The nudge controls are found on the LiveArt toolbar as illustrated below.

· Use the first four controls to move the model up, down, or sideways in the indicated directions. The model will move in small 
steps, allowing for precise placement.
 

· Use the    next two controls to rotate the model toward or away from you.

· Use the next two controls to rotate the model from side to side.

· Use the next two controls to rotate the model clockwise or counterclockwise.

· Use the last two controls to zoom the model in or out, making it appear larger or smaller.



Overview of Style Options

Each style has a number of options that you can change to alter the appearance of    the model.
You can change the color  or the thickness of the lines in the drawing. You can change the color  of the whole object. You can also 
change the way the light shines on the object.



Rotating the Model

· To rotate the model like a spinning figure skater, hold down the left button and move the mouse across the model from left to 
right or right to left.

· To rotate the model like a somersault end-over-end, hold down the left button and move the mouse up or down across the 
model.
(Moving the mouse in other directions will rotate the mouse around an axis tilted according to your movement.)

· To force rotation to be either side to side or up and down, hold down the Shift key along with the left mouse button.



· To rotate the model around the Z axis (a line from your eyes to the screen), hold down the Control key along with the left 
mouse button.



Searching by Keyword or Concept

 
The LiveArt catalog assigns keywords to each LiveArt model. The keywords represent objects or concepts related to what is 
depicted in the art. A built-in thesaurus function allows for matching a keyword with similar words. (For example, "cat," "feline," "lion," 
etc.) 

By default, if you list one or more keywords models matching any of these keywords or their synonyms will be retrieved.
Thus dog will retrieve anything to do with dogs, including types of dogs such as boxer. 
A search for dog cat will retrieve anything to do with dogs, cats, or their synonyms.

To do an exact search that retrieves only the word and no synonyms, put a plus sign in front of the word.
A search for +dog retrieves only "dog," without synonyms.

To search for only models whose keywords match all  the search words, put a plus sign before the second or later words.
+helicopter +navy retrieves only navy helicopters, not army or civilian ones.

Because the search engine matches synonyms by default, you can get unexpected results.
For example, a search for duck will also get truck. This is because "dodge"
is a synonym for "duck," but Dodge is also a kind of truck...

However, you can narrow a search by excluding some results. Do this by putting a minus sign in front of the word to be excluded. 
For example, +helicopter -navy retrieves only helicopters that are not navy ones. Note that the + in front of helicopter means that 
no synonyms for helicopter will be matched.
 



Turning on Direct 3D Acceleration

Many modern video cards have support for hardware acceleration that can speed up the rendering of models and backgrounds. 
Viewpoint LiveArt automatically detects and uses Open GL acceleration for normal rendering if your graphics hardware supports it. 

You can also use Direct 3D support if your hardware supports it. To activate Direct 3D acceleration:

1. Click on the Windows Start button

2. Move the cursor to Programs. When the Program menu opens, move the cursor to Viewpoint Live Art.

3. Select LiveArt Preferences.

Note: if your system does not support Direct 3D hardware acceleration you will receive an error message.



Uninstalling LiveArt

If you want to remove LiveArt from your system:

1. Click on the Windows Start button

2. Select Settings, then Control Panel

3. Select Add/Remove Programs

4. Select Viewpoint LiveArt from the program list

5. Follow the instructions on the screen to remove LiveArt from your computer. 



Using LiveArt in MS PowerPoint

1. Create or open a document in MS PowerPoint.

2. Click the location in the document where you want live art to be inserted.

3. Open the Insert menu and select Object.

4. Select Viewpoint LiveArt from the list of objects.

5. The LiveArt Catalog will appear.

6. After you select a model from the catalog, it will be inserted into a LiveArt canvas in your document.
  
The canvas will include a LiveArt toolbar that you can use to modify the art:
  



Using LiveArt in MS Word

1. Create or open a document in MS Word.

2. Click the location in the document where you want live art to be inserted.

3. Open the Insert menu and select Object.
Select Viewpoint LiveArt from the list of objects.

4. The LiveArt Catalog will appear.

5. After you select a model from the catalog, it will be inserted into a LiveArt canvas in your document.
  
The canvas will include a LiveArt toolbar that you can use to modify the art:
  



Using the Animation toolbar

Canvases with models that support animation will show the    animation control as illustrated below.

· To play or pause the animation, toggle the first button on the left of the animation control.

· Use the next set of four buttons to set the animation to the beginning, step back or forward one frame, or go to the end.

· To switch between running the animation once or running it in a continual loop, toggle the button at the far right of the 
animatiion control.

· You can also have an animation run automatically as part of a presentation in    MS PowerPoint.

Click on any button on the toolbar below to see what it does.



Using the LiveArt Control with Other OLE 2 Applications

LiveArt uses OLE (object linking and embedding) technology to put its art into your application programs.
While LiveArt has only been tested extensively with Microsoft Word and Microsoft PowerPoint, it may work    in other programs that 
support OLE 2. 

To find out whether LiveArt will work in your program, try the following steps:

1. Open a document in your application.

2. Look on the Insert menu for an Object item. 

3. Check to see whether Viewpoint LiveArt is listed as one of the object types.

4. If it is, click on it and a LiveArt canvas (and the LiveArt Catalog) should appear.



Using the LiveArt toolbar

When a canvas is active, the LiveArt toolbar appears. You use it to apply styles, properties, and actions to the model displayed on 
the canvas.

In the picture below, click on any button to learn what it does.

 



Using the Picture Toolbar

Once a LiveArt canvas is inactive, it becomes like any other picture inserted in an MS Word or MS PowerPoint document. You can 
bring up the Picture toolbar in these applications and use it to further modify your art.

· Make sure the canvas is inactive. (If necessary, click outside it to deactivate).

· Select Customize from the Tools menu in Word or PowerPoint.

· Making sure the Toolbars tab is selected, click on the checkbox for Picture so a check appears in it.

· or, in MS Word you can left click on the Word Toolbar

· Choose Picture from the pop-up menu

You will see a Picture toolbar like this:

 
The picture toolbar is part of your application, not part of LiveArt. See your application's help for more information on how you can 
edit pictures.



What is LiveArt?

Welcome to LiveArt.    The outside of the box says this is "Instant Art" but what exactly does that mean?    LiveArt is much more than 
a library of clip art that you can paste in your documents and presentations. LiveArt is more like an art studio that you can call on 
anywhere you need unique, customizable illustrations.    LiveArt is a collection of models and the artistic rendering technology that 
makes them look like hand-created art.

Using LiveArt involves these simple steps:

1. Run MS Word, MS PowerPoint, or any other fully OLE 2-enabled application to work with LiveArt right inside that program. Or 
use the LiveArt Sketchpad to export LiveArt images to your favorite graphics or web program.

2. Insert a LiveArt canvas wherever you need an illustration in your document or presentation.

3. Search or browse    the LiveArt model collection for the picture you want.

4. Customize the picture to suit your needs, for example, by moving the object around,    selecting a different style for the object, 
or changing the options for the current style. 
  
You can also animate many LiveArt models.



Working with the LiveArt Canvas

The rectangular area containing the LiveArt model is called the canvas.

The canvas can either be active or inactive.

To make a canvas active, double-click anywhere inside it. Sizing handles will appear at the corners and sides of the canvas. You 
can now do things such as:

· move the model around     or rotate the object by dragging it with the mouse.

· change the background 

· change the style options

· change the model

When a canvas is inactive, it acts just like any other picture in your document. It can be moved around the page, lightened, 
darkened, cropped and have any other picture type tricks applied to it. An inactive canvas has none of the features that make a 
LiveArt dynamic 3D object.You can't change its associated style or other characteristics.



Note: If you resize an inactive canvas in your application, reactivate it so the picture will be redrawn properly. 



Wrapping Text with Art in MS Word

You can wrap text around a LiveArt image in MS Word.

1. Create a transparent background for the LiveArt canvas.

2. With the canvas inactive, bring up the picture  toolbar.

3. Drag the canvas so it is over the text you want to wrap, as shown below:

4. Click the Wrapping control and select tight.

The text will now wrap around the picture as shown below:

  
Note that word wraps will not rewrap if you reshape the model after you've done a wrap.You need to do a new control and start the 
wrap again.



Zooming or Shrinking the Model

· To zoom the model (make it appear larger), hold down both mouse buttons and move the mouse up across the model.

· To shrink the model, hold down both mouse buttons and move the mouse down across the model.
Note: this is a very sensitive control. Move the mouse just a bit. If you lose track of the model, click on the Reset Model button 
on the LiveArt toolbar to restore defaults.





Getting started with the LiveArt Sketchpad

1. Start the program. (Select it from the Viewpoint LiveArt    folder in Programs.    You can also select it through the Windows Start 
menu, under Programs and then Viewpoint LiveArt.)

2. When you start the Sketchpad, it brings up the LiveArt Catalog for you to select the LiveArt you want to work with.    See [Insert]

3. Either type in what you’d like to search for, or select a category from the Search pull down button to the right of the Find box.

4. Select the insert button.    Play to your hearts content.



Using The LiveArt Sketchpad
The LiveArt Sketchpad is a simple program that you can use to work with a piece of LiveArt, then either save it or export it to your 
favorite programs.    It will export in several standard graphic file formats (PNG, BMP, JPEG, and TIFF).    You can also do simple 
printing. 

There are very few differences in working with the Sketchpad from working inside one of the Office™ applications.    Besides the 
export to the graphic file formats, the model you are working with in the Sketchpad is always active.    In Office, LiveArt waits for you 
to “wake it up” by double clicking to activate it.    There are also a bunch of special tricks that Word and PowerPoint let you do with 
LiveArt, such as putting in fancier backgrounds, and animating the models.    The Sketchpad is designed to make it easier to work 
with any program that can import one of the standard file formats.



Getting started with Sketchpad

1. Start the program. (Select it from the Viewpoint LiveArt    folder in Programs.    You can also select it through the Windows 
Start menu, under Programs and then Viewpoint LiveArt.)

2. When you start the Sketchpad, it brings up the LiveArt Catalog for you to select the LiveArt you want to work with.    See page 
[Insert]

3. Either type in what you’d like to search for, or select a category from the Search pull down button to the right of the 
Find box.

4. Select the insert button.    Play to your hearts content. For how to work with LiveArt, see page [insert page].



 Changing the size of the Sketch Paper
The sketch paper can be resized one of two ways:

1. Select the Sketch Size menu item from the View Menu. Type in the size you want.    You can also choose the units you would 
like to use here.

Or
2. Grab on of the corners and pull.      You know you have the corners when the cursor changes to the following symbol. 

NOTE: Remember…you can also change the size of a piece of LiveArt when you export to a different graphic format…but the 
proportions stay the same.





Saving Sketchpad documents
Sketchpad will save LiveArt with all the styles and in the size and proportion you have set up so that you can use it again later.    If 
you are familiar with standard saving, you don’t need to read this.

1. Select Save… or Save As… from the File Menu

2. Type in the name that you want to name the file.    (If you have selected Save As, you will be making a new copy, and leaving 
the previous one unchanged since the last time you saved.)

3. Click on the Save Button.



Exporting from LiveArt Sketchpad
LiveArt Sketchpad lets you export your LiveArt into one of several standard graphics formats.    These are Bitmap(.bmp), PNG 
(.png), JPEG (.jpg), and TIFF (.tif).

To export from LiveArt Sketchpad:

1.  Go to the Export…item in the File menu. (You can also click on the export button[show illustration]) 

2. Select the file format you would like to save to and type in the name of the file.

3. Press the save button or the Enter Key.    You will then be given an options dialog box depending on which file format you’ve 
chosen.

4. Type in the options for that format.    (Most will give you some compression options, and the option to change the exported 
image’s size.    The default is the original size you were playing with on screen.

5. Say OK and the file will be saved.

NOTE:    You can not open up an exported file back into LiveArt Sketchpad.    To view the exported file, bring them in an external 
program.

Each of the different export file formats has a few different options.    After you select save, the options dialog appear and let you 
make any special changes for that format.

Bitmap(.bmp) is the standard bitmap format for Windows based computers. You can choose 1-2-4-8-24 bit depths to save the 
image in.    (Bit depth is the number of possible colors—1-bit is black and white, to 24-bit which is 16.7 million colors)    The higher 
the bit-depth, the better the image will look and the larger the file size will be. 



PNG is a format that was designed to be used to display images on the World Wide Web.    It is supported by the newest generation 
of web browsers such as Internet Explorer 4.0 and Netscape Navigator 4.0 and greater.    It is not supported by the previous 
browsers.    It automatically includes loseless compression to make the downloads quicker, and will display with gradually increasing 
detail if you chose the interlace option when you save it out.

JPEG (Joint Photographic Experts Group) is designed to compress images for either print or use on the World Wide Web. It is a 
“lossy” compression format.    That means that the greater the compression you use, the more quality of the image will be lost.    This 
is balanced with what is often the most reduced file sizes. It is also almost universally supported on the web and by graphics 
programs.    Like PNG, you can save JPEG’s in such a way that they will download a sequence of increasingly detailed images in a 
progression until the full image is displayed.    Just save out using the Progressive option.

TIFF (Tagged-image File Format) is a standard format between programs.    This is a good format to use to take into desktop 
publishing programs.    The file sizes will be larger then the compressed formats.



Printing From LiveArt Sketchpad
Sketchpad will print a simple version of the LiveArt your working with, either as a preview, or just to show off what you’ve made.    
The image will be centered on the page, and printed out at the printer’s maximum resolution, unless you specify differently through 
your printers options.

NOTE:    LiveArt printing was not designed to work as a page layout program.    To create complete work with LiveArt, bring it in as 
an element in your favorite layout, web, or presentation package.

1. Select Print from the File Menu.

2. Set any options for your printer.

3. Choose Print.






